# Table of Contents

Overview ......................................................................................................................... iv  
How it works .................................................................................................................. iv  
About the manual ........................................................................................................ iv  
1. Installation .................................................................................................................. 1  
   System requirements ............................................................................................... 1  
   OpenCL acceleration ............................................................................................... 1  
   Installation procedure ............................................................................................ 2  
   Restrictions of the Demo mode ............................................................................ 2  
2. Capturing photos ....................................................................................................... 4  
   Basic rules ............................................................................................................... 4  
   Capturing scenarios ............................................................................................... 4  
   Restrictions ............................................................................................................ 5  
3. General workflow ...................................................................................................... 7  
   Loading photos ....................................................................................................... 7  
   Aligning photos ..................................................................................................... 8  
   Building model geometry .................................................................................... 9  
   Building model texture ....................................................................................... 10  
   Saving intermediate results .............................................................................. 12  
   Exporting results ................................................................................................. 12  
4. Advanced use ........................................................................................................... 18  
   Splitting project ................................................................................................... 18  
   Camera calibration ............................................................................................... 20  
   Using masks .......................................................................................................... 22  
   Editing sparse point cloud .................................................................................. 26  
   Editing model geometry ..................................................................................... 27  
   Setting coordinate system ............................................................................... 29  
   Performing measurements ............................................................................... 35  
   Multispectral imagery ....................................................................................... 37  
   4D processing ...................................................................................................... 37  
   Python scripting ................................................................................................. 39  
A. Graphical User Interface .......................................................................................... 40  
   Application Window ............................................................................................ 40  
   Menu Commands ............................................................................................... 43  
   Toolbar Buttons ................................................................................................. 46  
B. Troubleshooting ....................................................................................................... 48  
   Photo alignment succeeds, but the resulting camera positions appear to be wrong .. 48  
   Reconstructed geometry appears to be cut and some important parts are missing ... 48  
   The photos included in the project file can't be opened and operations from the Workflow menu fail .............................................................. 49
Overview

Agisoft PhotoScan is an advanced image-based 3D modeling solution aimed at creating professional quality 3D content from still images. Based on the latest multi-view 3D reconstruction technology, it operates with arbitrary images and is efficient in both controlled and uncontrolled conditions. Photos can be taken from any position, providing that the object to be reconstructed is visible on at least two photos. Both image alignment and 3D model reconstruction are fully automated.

How it works

Generally the final goal of photographs processing by PhotoScan is to build a textured 3D model. The procedure of photographs processing and 3D model construction comprises three main stages.

1. The first stage is photographs alignment. At this stage PhotoScan searches for common points on photographs and matches them, as well as it finds the position of the camera for each picture and refines camera calibration parameters. As a result a sparse point cloud and a set of camera positions are formed.

The point cloud represents the results of photos alignment and will not be directly used in the further 3D model construction procedure (except for the point cloud based reconstruction method). However it can be exported for further usage in external programs. For instance, the point cloud model can be used in a 3D editor as a reference.

On the contrary the set of camera positions is required for further 3D model construction by PhotoScan.

2. The next stage is building geometry. Based on the estimated camera positions and pictures themselves a 3D polygon mesh, representing the object surface, is build by PhotoScan. Four algorithmic methods available in PhotoScan can be applied to 3D mesh generation: Arbitrary - Smooth, Arbitrary - Sharp, Height field - Smooth and Height field - Sharp methods. Additionally there is a Point Cloud based method for fast geometry generation based on the sparse point cloud alone.

Having built the mesh, it may be necessary to edit it. Some corrections, such as mesh decimation, removal of detached components, closing of holes in the mesh, etc. can be performed by PhotoScan. For more complex editing you have to engage external 3D editor tools. PhotoScan allows to export the mesh, edit it by another software and import it back.

3. After the geometry (i.e. the mesh) is constructed, it can be textured and / or used for orthophoto generation. Several texturing modes are available in PhotoScan, they are described in the corresponding section of this manual.

About the manual

Basically, the sequence of actions described above covers most of the model processing needs. All these operations are carried out automatically according to the parameters set by user. Instructions on how to get through these operations and descriptions of the parameters controlling each step are explained in the corresponding sections of the Chapter 3, General workflow.

In some cases, however, additional actions may be required to get the desired results. For instance, pictures taken using uncommon lenses such as fish-eyes may require preliminary calibration of optical system parameters. In some capturing scenarios masking of certain regions of the photos may be required to exclude them from the calculations. Having built up a model you can set a reference system for it and carry out typical measurements such as calculating the surface area and volume of the model. All these advanced functions are described in the Chapter 4, Advanced use.
It can take up quite a long time to reconstruct a 3D model. PhotoScan allows to export obtained results and save intermediate data in a form of project files at any stage of the process. If you are not familiar with the concept of projects, its brief description is given at the end of the Chapter 3, General workflow.

In the manual you can also find instructions on the PhotoScan installation procedure and basic rules for taking "good" photographs, i.e. pictures that provide most necessary information for 3D reconstruction.
Chapter 1. Installation

System requirements

Minimal configuration

- Windows XP or later (32 or 64 bit), Mac OS X Snow Leopard or later, Debian / Ubuntu (64 bit)
- Intel Core 2 Duo processor or equivalent
- 2GB of RAM

Recommended configuration

- Windows XP or later (64 bit), Mac OS X Snow Leopard or later, Debian / Ubuntu (64 bit)
- Intel Core i7 processor
- 12GB of RAM

The number of photos that can be processed by PhotoScan depends on the available RAM and reconstruction parameters used. Assuming that a single photo resolution is of the order of 10 MPx, 2GB RAM is sufficient to make a model based on 20 to 30 photos. 12GB RAM will allow to process up to 200-300 photographs.

OpenCL acceleration

PhotoScan supports accelerated geometry reconstruction due to exploiting of the graphics hardware (GPU).

NVidia
- GeForce 8xxx series and later.

ATI
- Radeon HD 5xxx series and later.

PhotoScan allegedly is able to utilize processing power of any OpenCL enabled device, provided that OpenCL drivers for the device are properly installed. However, due to the large number of various combinations of video chips, driver versions and operating systems, we are unable to test and guarantee PhotoScan's compatibility with every device and on every platform.

The table below lists currently supported devices (on Windows platform only). We will pay particular attention to possible problems with PhotoScan running on these devices.

Table 1.1. Supported Desktop GPUs on Windows platform

<table>
<thead>
<tr>
<th>NVIDIA</th>
<th>AMD</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeForce GTX 680</td>
<td>Radeon HD 7970</td>
</tr>
<tr>
<td>GeForce GTX 580</td>
<td>Radeon HD 6970</td>
</tr>
<tr>
<td>GeForce GTX 570</td>
<td>Radeon HD 6950</td>
</tr>
</tbody>
</table>
Although PhotoScan is supposed to be able to utilize other GPU models and on other operating systems than Windows, we do not guarantee that it will work correctly.

**Note**

- OpenCL acceleration can be enabled using OpenCL tab in the Preferences dialog box.
- Using OpenCL acceleration with mobile video chips is not recommended because of the low performance of mobile GPUs.

### Installation procedure

**Installing PhotoScan on Microsoft Windows**

To install PhotoScan on Microsoft Windows simply run the downloaded msi file and follow the instructions.

**Installing PhotoScan on Mac OS X**

Open the downloaded dmg image and drag PhotoScan application to the desired location on your hard drive.

**Installing PhotoScan on Debian/Ubuntu**

Unpack the downloaded archive with a program distribution kit to the desired location on your hard drive. Start PhotoScan by running photoscan.sh script from the program folder.

### Restrictions of the Demo mode

Once PhotoScan is downloaded and installed on your computer you can run it either in the Demo mode or in the full function mode. At every run until you enter a serial number it will show a registration box offering two options: (1) use PhotoScan in the Demo mode or (2) enter the serial number to confirm the purchase. The first choice is set by default, so if you are still exploring PhotoScan click the Continue button and PhotoScan will start in the Demo mode.

The employment of PhotoScan in the Demo mode is not time limited. Several functions, however, are not available in the Demo mode. These functions are the following:

- saving the project;
- exporting reconstruction results (you can only view a 3D model on the screen).
To use PhotoScan in the full function mode you have to purchase it. On purchasing you will get the serial number to enter into the registration box on starting PhotoScan. Once the serial number is entered the registration box will not appear again and you will get full access to all functions of the program.
Chapter 2. Capturing photos

Before loading your photographs into PhotoScan you need to take them and select those suitable for 3D model reconstruction.

Photographs can be taken by any standard digital camera, as long as you follow some specific capturing guidelines. This section explains the general principles of taking and selecting pictures that provide the most appropriate data for 3D model generation.

Basic rules

• Use a digital camera with reasonably high resolution (5 MPix or more).
• Wide angle lenses suit better for reconstructing spatial relations between objects than telephoto ones.
• Avoid not textured and flat objects or scenes.
• Avoid shiny and transparent objects.
• Avoid unwanted foregrounds and moving objects as much as possible.
• Shoot shiny objects under a cloudy sky.
• Shoot pictures of the scene with a lot of overlap.
• Capture most important scene content from multiple viewpoints (3 or more).
• Do not crop or geometrically transform the images.
• More photos is better than not enough.
• Spending some time planning your shot might be very useful.
• If you intend to set a reference coordinate system for reconstructed 3D model, make sure to identify or place on ground markers that will be used to set reference coordinate system and scale. Measure reference distance.
• Make sure to study the following schemes and read the list of restrictions before you get out for shooting photographs.

Capturing scenarios

The following figures represent several typical capturing scenarios:
Restrictions

In some cases it might be very difficult or even impossible to build a correct 3D model from a set of pictures. A short list of typical reasons for photographs unsuitability is given below.

Modifications of photographs

PhotoScan can process only unmodified photos as they were taken by a digital photo camera. Processing the photos which were manually cropped or geometrically warped is likely to fail or produce highly inaccurate results. Photometric modifications do not affect reconstruction results.
Lack of EXIF data

To estimate the field of view for each photo PhotoScan uses the information saved in the EXIF part of each picture. If EXIF data are available you can expect to get the best possible 3D reconstruction. However 3D scene can also be reconstructed in the absence of EXIF data. In this case PhotoScan assumes that the 35mm focal length equivalent equals to 50 mm and tries to align the photos in accordance with this assumption. If the correct focal length value differs significantly from 50 mm, the alignment can give incorrect results or even fail. In such cases it is required to specify initial camera calibration manually.

The details of necessary EXIF tags and instructions for manual setting of the calibration parameters are given in the Camera calibration section.

Lens distortion

The distortion of the lens being used to capture the photos should be well modeled using the Brown's distortion model. Otherwise it is almost impossible to build a precise 3D model. Fish eyes and ultra-wide angle lenses are poorly modeled by the distortion model implemented, which leads to inaccurate reconstructions.
Chapter 3. General workflow

The processing of images by PhotoScan includes the following main steps:

- loading photos into PhotoScan;
- inspecting loaded images, removing unnecessary images;
- aligning photos;
- building 3D model;
- editing 3D model;
- exporting results.

If you are using PhotoScan in the full function (not the Demo) mode, intermediate results of the image processing can be saved at any stage in the form of project files and can be used later. The concept of projects and project files is briefly explained in the Saving intermediate results section.

The list above represents all the necessary steps involved in the construction of a textured 3D model from your photos. Some additional tools, which you may find to be useful, are described in the Chapter 4, Advanced use.

Loading photos

Before starting any operation it is necessary to point out what photos will be used as a source for 3D reconstruction. In fact, photographs themselves are not loaded into PhotoScan until they are needed. So, when you "load photos" you only indicate photographs that will be used for further processing.

To load a set of photos

1. Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.
2. In the Add Photos dialog box browse to the folder containing the images and select files to be processed. Then click Open button.

Note

- PhotoScan accepts the following image formats: JPEG, TIFF, PNG, BMP, PPM, OpenEXR and JPEG Multi-Picture Format (MPO). Photos in any other format will not be shown in the Add Photos dialog box. To work with such photos you will need to convert them in one of the supported formats.

If you have loaded some unwanted photos, you can easily remove them at any moment.

To remove unwanted photos

1. On the Workspace pane select the photos to be removed.
General workflow

2. Right-click on the selected photos and choose Remove Items command from the opened context menu, or click Remove Items toolbar button. The selected photos will be removed from the working set.

Inspecting the loaded photos

Loaded photos are displayed on the Workspace pane along with flags reflecting their status.

The following flags can appear next to the photo name:

NC (Not calibrated)
Notifies that the EXIF data available is not sufficient to estimate the camera focal length. In this case PhotoScan assumes that the corresponding photo was taken using 50mm lens (35mm film equivalent). If the actual focal length differs significantly from this value, manual calibration may be required. More details on manual camera calibration can be found in the Camera calibration section.

NA (Not aligned)
Notifies that external camera orientation parameters were not estimated for the current photo yet.

Images loaded to PhotoScan will not be aligned until you perform the next step - photos alignment.

Aligning photos

Once photos are loaded into PhotoScan, they need to be aligned. At this stage PhotoScan finds the camera position for each photo and builds a point cloud model.

To align a set of photos

1. Select Align Photos... command from the Workflow menu.
2. In the Align Photos dialog box select the desired alignment options. Click OK button when done.
3. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

Alignment having been completed, computed camera positions and a sparse point cloud will be displayed. You can inspect alignment results and remove incorrectly positioned photos, if any. To see the matches between any two photos use View Matches... command from the Tools menu.

The point cloud and estimated camera positions can be exported for processing with another software if needed.

Incorrectly positioned photos can be realigned.

To realign a subset of photos

1. Reset alignment for incorrectly positioned photos using Reset Photo Alignment command from the photo context menu.
2. Set markers (at least 4 per photo) on these photos and indicate their projections on at least two photos from the already aligned subset. PhotoScan will consider these points to be true matches. (For information on markers placement refer to the Setting coordinate system section).
3. Select photos to be realigned and use Align Selected Photos command from the photo context menu.
4. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

**Alignment parameters**

The following parameters control the photo alignment procedure and can be modified in the Align Photos dialog box:

**Accuracy**
Higher accuracy setting helps to obtain more accurate camera position estimates. Lower accuracy setting can be used to get the rough camera positions in a shorter period of time.

**Pair preselection**
The alignment process of large photo sets can take a long time. A significant portion of this time period is spent on matching of detected features across the photos. Image pair preselection option may speed up this process due to selection of a subset of image pairs to be matched. In the Generic preselection mode the overlapping pairs of photos are selected by matching photos using lower accuracy setting first. In the Ground Control preselection mode the overlapping pairs of photos are selected basing on the measured camera locations (if present).

**Constrain features by mask**
When this option is enabled, features detected in the masked image regions are discarded. For additional information on the usage of masks please refer to the Using masks section.

**Building model geometry**

3D model reconstruction is a computationally intensive operation and can take a long time, depending on the quantity and resolution of loaded photos. It is recommended to build a model with the lowest quality first to estimate the applicability of the chosen reconstruction method, and then to recompute the results using a higher quality setting. It is also recommended to save the project before building the geometry.

**To build a 3D model**

1. Check the reconstruction volume bounding box. To adjust the bounding box use the Resize Region and Rotate Region toolbar buttons. Rotate the bounding box and then drag corners of the box to the desired positions. If the Height field reconstruction method is applied, the red side of the bounding box will define the reconstruction plane. In this case make sure that the bounding box is correctly oriented.

2. Select the Build Geometry... command from the Workflow menu.

3. In the Build Geometry dialog box select the desired reconstruction parameters. Click OK button when done.

4. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

**Reconstruction methods**

PhotoScan supports several reconstruction methods and settings, which help to produce optimal reconstructions for a given data set.
Object type

Arbitrary

Arbitrary object type can be used for modeling of any kind of object. It should be selected for closed objects, such as statues, buildings, etc. It doesn't make any assumptions on the type of the object modeled, which comes at a cost of higher memory consumption.

Height field

The Height field object type is optimized for modeling of planar surfaces, such as terrains or bas-reliefs. It should be selected for aerial photography processing as it requires lower amount of memory and allows for larger data sets processing.

Geometry type

Sharp

Sharp geometry type option leads to more accurate reconstruction results and does not introduce extra geometry, like hole filling "patches". Manual hole filling is usually required at the post processing step.

Smooth

Smooth geometry type option produces watertight reconstructions with no or little holes on resulting surface. Large areas of extra geometry might be generated with this method, but they could be easily removed later using selection and cropping tools. Smooth setting is recommended for orthophoto generation.

Reconstruction parameters

Quality

Specifies the desired reconstruction quality. Higher quality settings can be used to obtain more detailed and accurate geometry, but require longer time for processing. Point Cloud quality setting is used for fast 3D model generation based solely on the sparse point cloud. The option is available for Smooth geometry type only.

Face count

Specifies the maximum face count in the final mesh. 0 - if no decimation is required.

Filter threshold

Specifies the maximum face count of small connected components to be removed after surface reconstruction (in percent of the total face count). The 0 value disables connected component filtering.

Hole threshold (Height field methods only)

Specifies the maximum size of holes to be filled after surface reconstruction (in percent of the total surface area). The 0 value disables automatic hole filling.

Note

- PhotoScan tends to produce 3D models with excessive geometry resolution, so it is recommended to perform mesh decimation after geometry computation. More information on mesh decimation and other 3D model geometry editing tools is given in the Editing model geometry section.

Building model texture

To generate 3D model texture

1. Select Build Texture... command from the Workflow menu.
2. Select the desired texture generation parameters in the Build Texture dialog box. Click OK button when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

**Texture mapping modes**

The texture mapping mode determines how the object texture will be packed in the texture atlas. Proper texture mapping mode selection helps to obtain optimal texture packing and, consequently, better visual quality of the final model.

**Generic**
The default mode is the **Generic** mapping mode; it allows to parameterize texture atlas for arbitrary geometry. No assumptions regarding the type of the scene to be processed are made; program tries to create as uniform texture as possible.

**Adaptive orthophoto**
In the **Adaptive orthophoto** mapping mode the object surface is split into the flat part and vertical regions. The flat part of the surface is textured using the orthographic projection, while vertical regions are textured separately to maintain accurate texture representation in such regions. When in the **Adaptive orthophoto** mapping mode, program tends to produce more compact texture representation for nearly planar scenes, while maintaining good texture quality for vertical surfaces, such as walls of the buildings.

**Orthophoto**
In the **Orthophoto** mapping mode the whole object surface is textured in the orthographic projection. The **Orthophoto** mapping mode produces even more compact texture representation than the **Adaptive orthophoto** mode at the expense of texture quality in vertical regions.

**Single photo**
The **Single photo** mapping mode allows to generate texture from a single photo. The photo to be used for texturing can be selected from Texture from list.

**Keep uv**
The **Keep uv** mapping mode generates texture atlas using current texture parameterization. It can be used to rebuild texture atlas using different resolution or to generate the atlas for the model parametrized in the external software.

**Texture generation parameters**

The following parameters control various aspects of texture atlas generation:

**Texture from (Single photo mapping mode only)**
Specifies the photo to be used for texturing. Available only in the **Single photo** mapping mode.

**Blending mode (not used in Single photo mode)**
Selects the way how pixel values from different photos will be combined in the final texture.

**Average** - uses the average value of all pixels from individual photos.

**Mosaic** - gives more quality for orthophoto and texture atlas than **Average** mode, since it does not mix image details of overlapping photos but uses more appropriate photo. Mosaic texture blending mode is especially useful for orthophoto generation based on approximate geometric model.
**Max Intensity** - the photo which has maximum intensity of the corresponding pixel is selected.

**Min Intensity** - the photo which has minimum intensity of the corresponding pixel is selected.

**Fill holes**
Enables hole filling for contiguous, orthophoto-like texture generation. Recommended for use only combined with Height-field geometry reconstruction mode. It is recommended to disable hole filling option when texturing stand-alone objects reconstructed in Arbitrary mode.

**Atlas width**
Specifies the width of the texture atlas in pixels.

**Atlas height**
Specifies the height of the texture atlas in pixels.

**Color depth**
Specifies the target texture color depth (Standard or HDR). HDR texture generation requires HDR photos on input.

### Saving intermediate results

Certain stages of 3D model reconstruction can take a long time. The full chain of operations could easily last for 4-6 hours when building a model from hundreds of photos. It is not always possible to finish all the operations in one run. PhotoScan allows to save intermediate results in a project file.

PhotoScan project files may contain the following information:

- List of loaded photographs with reference paths to the image files.
- Photo alignment data such as information on camera positions, point cloud model and set of refined camera calibration parameters for each photo.
- Masks applied to the photos in project.
- Reconstructed 3D model with any changes made by user. This includes geometry and texture if they were built.
- List of added markers and information on their positions.
- Structure of the project, i.e. number of chunks in the project and their content.

You can save the project at the end of any processing stage and return to it later. To restart work simply load the corresponding file into PhotoScan. Project files can also serve as backup files or be used to save different versions of the same model.

Project files use relative paths to reference original photos. Thus, when moving or copying the project file to another location do not forget to move or copy photographs with all the folder structure involved as well. Otherwise, PhotoScan will fail to run any operation requiring source images, although the project file including the reconstructed model will be loaded up correctly.

### Exporting results

PhotoScan supports export of processing results in various representations. Sparse and dense point clouds, camera calibration data, 3D models, orthophotos, and digital elevation models can be generated according to the user requirements.
General workflow

Point clouds and camera calibration data can be exported right after photo alignment is completed. All other export options are available after the geometry is built.

In some cases editing model geometry in the external software may be required. PhotoScan supports model export for editing in external software and then allows to import it back, as it is described in the Editing model geometry section of the manual.

**Point Cloud export**

**To export sparse or dense point cloud**

1. Select Export Points... command from the File menu.
2. Browse the destination folder, choose the file type, and print in the file name. Click Save button.
3. In the Export Points dialog box set the Point Cloud value for the Quality parameter if you need to export sparse point cloud. To export a dense point cloud choose an appropriate quality among the rest of the values.
4. Specify the coordinate system and indicate export parameters applicable to the selected file type.
5. Click OK button to start export.
6. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

In some cases it may be reasonable to edit sparse point cloud before exporting it. To read about point cloud editing refer to the Editing sparse point cloud section of the manual.

PhotoScan supports point cloud export in the following formats:

- Wavefront OBJ
- Stanford PLY
- XYZ text file format
- ASPRS LAS

⚠ **Note**

- Saving color information of the point cloud is supported by the PLY, TXT and LAS file formats.
- Saving point normals information is supported by the OBJ, PLY and TXT file formats.

**Camera calibration and positions data export**

To export camera calibration and positions data select Export Cameras... command from the Tools menu.

To export / import only camera calibration data select Camera Calibration... command from the Tools menu.

PhotoScan supports camera data export in the following formats:

- PhotoScan structure file format (XML based)
General workflow

- Bundler OUT file format
- CHAN file format
- Boujou TXT file format
- Omega Phi Kappa text file format

しようと

- Camera data export in Bundler and Boujou file formats will save sparse point cloud data in the same file.
- Camera data export in Bundler file format would not save distortion coefficient k3.

3D model export

To export 3D model

1. Select Export Model... command from the File menu.
2. Browse the destination folder, choose the file type, and print in the file name. Click Save button.
3. In the Export Model dialog specify the coordinate system and indicate export parameters applicable to the selected file type.
4. Click OK button to start export.
5. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

しようと

- If the model is referenced in local coordinates, PhotoScan can write a KML file for the exported model to be correctly located on Google maps.

PhotoScan supports model export in the following formats:

- Wavefront OBJ
- 3DS file format
- VRML
- COLLADA
- Stanford PLY
- Autodesk DXF
- U3D
- Adobe PDF

Some file formats (OBJ, 3DS, VRML, COLLADA, PLY) save texture image in a separate file. The texture file should be kept in the same directory as the main file describing the geometry. If the texture atlas was not built only the model geometry is exported.
Orthophoto export

Orthophoto export is normally used for generation of high resolution imagery based on the source photos and reconstructed geometry. The most common application is aerial photographic survey processing, but it may be also useful when a detailed view of the object is required. Orthophoto is often accompanied by the digital elevation model (see the next section).

In order to export orthophoto in the correct orientation it is necessary to set the coordinate system for the model first. Since PhotoScan uses original images to build an orthophoto, there is no need to build a texture atlas.

To export Orthophoto

1. Select Export Orthophoto... command from the File menu.
2. In the Export Orthophoto dialog box specify coordinate system to georeference the Orthophoto.
3. Check Write KML file and / or Write World file options to create files needed to georeference the orthophoto in the Google Earth and / or a GIS.
4. Select Blending mode to be used for texture mapping. (For details please see the Building model texture section.)
5. Click Export button to start export.
6. Browse the destination folder, choose the file type, and print in the file name. Click Save button.
7. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

Note

- Write KML file option is available only if the model is georeferenced in WGS84 coordinate system due to the fact that Google Earth supports only this coordinate system.
- World file specifies coordinates of the four angle vertices of the exporting orthophoto. This information is already included in GeoTIFF file, however, you could duplicate it for some reason. If you need to export orthophoto in JPEG or PNG file formats and would like to have georeferencing data this informations could be useful.

PhotoScan allows to export Orthophoto in different planar projections as well. To export Orthophoto in a planar projection choose Planar Projection Type in Export Orthophoto dialog. You can select projection plane and orientation of the Orthophoto. PhotoScan provides an option to project the model to a plane determined by a set of markers (if there are no 3 markers in a desired projection plane it can be specified with 2 vectors, i. e. 4 markers).

Note

- Default value for pixel size in Export Orthophoto dialog refers to ground sampling resolution, thus, it is useless to set a smaller value: the number of pixels would increase, but the effective resolution would not.
- PhotoScan allows for automatic hole filling. Check Fill Holes option in the Export Orthophoto dialog to generate holeless orthophoto.
- Split in blocks option in the Export Orthophoto dialog can be useful for exporting large projects.
General workflow

- To export a particular part of the project use Region section of the Export Orthophoto dialog.

The following formats are supported for orthophoto export:

- JPEG
- PNG
- TIFF
- GeoTIFF
- Multiresolution Google Earth KML mosaic.

**Note**

- While exporting (Geo)TIFF file LZW compression is applied. If you need an original file or, on the contrary, more compressed file, you should use external software to do the transformation. However, one should be careful with the selected tool not to lose georeferencing information (in case of GeoTIFF file) during compression/decompression procedure.

**DEM export**

Digital elevation models (DEMs) represent the model surface as a regular grid of height values, and are often used for aerial photographic survey data. Digital elevation model can be combined with orthophoto to produce a 3D model of the area.

**To export DEM**

1. Select Export DEM... command from the File menu.
2. In the Export DEM dialog box specify coordinate system to georeference the DEM.
3. Check Write KML file and / or Write World file options to create files needed to georeference the DEM in the Google Earth and / or a GIS.
4. Click Export button to start export.
5. Browse the destination folder, choose the file type, and print in the file name. Click Save button.
6. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

**Note**

- Write KML file option is available only if the model is georeferenced in WGS84 coordinate system due to the fact that Google Earth supports only this coordinate system.

- World file specifies coordinates of the four angle vertices of the exporting DEM. This information is already included in GeoTIFF elevation data as well as in other supported file formats for DEM export, however, you could duplicate it for some reason.

PhotoScan allows to export DEM in different planar projections in the same way as it is done for orthophoto export. (See previous section.)
Note

- Unlike orthophoto export, it is sensible to set smaller pixel size compared to the default value in DEM export dialog; the effective resolution will increase.

- Export DEM dialog allows to crop invalid DEM (i.e. DEM parts corresponding to the areas visible on less than 2 source photos). The values for the points of the grid that couldn't be calculated will be set to the value indicated in no-data value box.

- Split in blocks option in the Export DEM dialog can be useful for exporting large projects or meeting special DEM requirements.

- To export a particular part of the project use Region section of the Export DEM dialog.

The following formats are supported for DEM export:

- GeoTIFF elevation data
- Arc/Info ASCII Grid (ASC)
- Band interlieved file format (BIL)
- XYZ file format

Processing report generation

PhotoScan supports automatic processing report generation in PDF format, which contains the basic parameters of the project, processing results and accuracy estimates.

To generate processing report

1. Select Generate Report... command from the File menu.
2. Browse the destination folder, choose the file type, and print in the file name. Click Save button.
3. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

PhotoScan processing report represents the following data:

- Orthophoto and digital elevation model sketch.
- Camera parameters and survey scheme.
- Image overlap statistics.
- Camera positioning error estimates.
- Ground control point error estimates.

Note

- Processing report can be exported only after geometry is constructed and georeferenced.
Chapter 4. Advanced use

Splitting project

In some cases it is very hard or even impossible to generate 3D model of the whole object in one go. This could happen for instance if the total amount of photographs is too large to be processed. To overcome this, PhotoScan offers the possibility of splitting the set of photos in several separate “chunks” within the project. The alignment of photos, building geometry and forming the texture atlas may be performed on each chunk separately and then the resulting 3D models may be combined together.

Working with chunks is no more difficult than using PhotoScan following the general workflow. In fact, in PhotoScan always exists at least one active chunk and all the 3D model processing workflow operations are applied to this chunk.

To work with several chunks you need to know how to create chunks and how to combine resulting 3D models from separate chunks into one model.

Creating a chunk

To create new chunk click on the Add Chunk toolbar button on the Workspace pane or select Add Chunk command from the Workspace context menu (available by right-clicking on the root element in the Workspace pane).

After the chunk is created you may load photos in it, align them, generate mesh surface model, build texture atlas, export the models at any stage and so on. The models in the chunks are not linked with each other.

To move photos from one chunk to another simply select them in the list of photos on the Workspace pane, and then drag and drop in the desirable chunk.

Working with chunks

All operations within the chunk are carried out following the common workflow: loading photographs, aligning them, building geometry model, building texture atlas, exporting 3D model and so on.

Note that all these operations are applied to the active chunk. When a new chunk is created it is activated automatically. Save project operation saves the content of all chunks.

To set another chunk as active

1. Right-click on the chunk title on the Workspace pane.
2. Select Set Active command from the context menu.

To remove chunk

1. Right-click on the chunk title on the Workspace pane.
2. Select Remove Items command from the context menu.

Aligning chunks

After the “partial” 3D models are built in several chunks they can be merged together. Before merging the models they need to be aligned.
To align models from separate chunks

1. Select Align Chunks command from the Workflow menu.

2. In the Align Chunks dialog box select chunks to be aligned, indicate reference chunk with a double-click. Set desired alignment options. Click OK button when done.

3. The progress dialog box will appear displaying the current processing status. To cancel processing click the Cancel button.

The following parameters control the chunks alignment procedure and can be modified in the Align Chunks dialog box:

Method
- Defines the chunks alignment method. Point based method alignes chunks by matching photos across the different chunks. Marker based method uses markers as common points between different chunks. The details on using markers are available in the Setting coordinate system section. Camera based method is used to align chunks based on estimated camera locations. Corresponding cameras should have the same label.

Accuracy (Point based alignment only)
- Higher accuracy setting helps to obtain more accurate chunk alignment results. Lower accuracy setting can be used to get the rough chunk alignment in the shorter time.

Preselect image pairs (Point based alignment only)
- The alignment process of many chunks may take a long time. A significant portion of this time is spent for matching of detected features across the photos. Image pair preselection option can speed up this process by selection of a subset of image pairs to be matched.

Constrain features by mask (Point based alignment only)
- When this option is enabled, features detected in the masked image regions are discarded. For additional information on the usage of masks refer to the Using masks section.

Note
- Chunk alignment can be performed only for chunks containing aligned photos.
- There is no need to perform chunk alignment for georeferenced chunks, as they are already in the same coordinate frame.

Merging chunks

After alignment is complete the separate models can be merged into a single model.

To merge models

1. Select Merge Chunks command from the Workflow menu.

2. In the Merge Chunks dialog box select chunks to be merged and the desired merging options. Click OK button when done.

3. PhotoScan will merge the separate chunks into one. The merged chunk will be displayed in the project content list on Workspace pane.

The following parameters control the chunks merging procedure and can be modified in the Merge Chunks dialog box:
**Merge models**
Defines if models from the selected chunks are merged.

**Merge markers**
Defines if markers from the selected chunks are merged (only markers with the same labels would be merged).

Chunks merging result (i.e. photos, points and geometry) will be stored in the new chunk and it may be treated as common chunk (e.g. textured and/or exported).

**Batch processing**

PhotoScan allows to perform general workflow operations with multiple chunks automatically. It is useful when dealing with a large number of chunks to be processed.

Batch processing can be applied to all chunks in the Workspace, to unprocessed chunks only, or to the chunks selected by the user.

Batch processing can perform the following operations:
- Align Photos
- Build Geometry
- Build Texture
- Decimate Mesh
- Import Cameras
- Export Model
- Align chunks
- Save project after every completed operation

**To start batch processing**
1. Select Batch Process... command from the Workflow menu.
2. Click Add to add the desired processing stages.
3. In the Add Job dialog select the kind of operation to be performed, the list of chunks it should be applied to, and desired processing parameters. Click OK button when done.
4. Repeat the previous steps to add other processing steps as required.
5. Arrange jobs by clicking Up and Down arrows by the right of the Batch Process... dialog box.
6. Click OK button to start processing.

**Camera calibration**

While carrying out photos alignment PhotoScan estimates both internal and external camera orientation parameters, including nonlinear radial distortions. For a successful estimation the information on approximate focal length values is required. Normally this data is extracted automatically from the EXIF
metadata, or the 50mm focal length (35mm film equivalent) is assumed if the EXIF information is insufficient.

In some cases, the 50mm guess can differ too much from the actual focal length. This can lead to the failure of the alignment process. In such cases it is required to specify the initial camera calibration manually.

**To specify camera calibration manually**

1. Select Camera Calibration... command from the Tools menu.
2. In the Camera Calibration dialog box, select Initial viewing mode. Select the photos to be calibrated.
3. Modify the calibration parameters displayed in the corresponding edit boxes. Normally only $f_x$, $f_y$, $c_x$ and $c_y$ values should be corrected.
4. Click Apply button to set the calibration. You will notice that the selected photos will be marked with the C flag (Custom calibration).
5. Click Close button to close the camera calibration dialog.

**Calibration parameters**

- $f_x$, $f_y$
  Focal length in x- and y-dimensions measured in pixels.
- $c_x$, $c_y$
  Principal point coordinates, i.e. coordinates of lens optical axis interception with sensor plane.
- skew
  Skew transformation coefficient.
- $k_1$, $k_2$, $k_3$
  Radial distortion coefficients.
- $p_1$, $p_2$
  Tangential distortion coefficients.

**How to set up appropriate values**

In the case of missing EXIF data or too large lens distortions manual setting of lens calibration may be required. This may happen if you used an old manual lens which cannot be detected by the camera or if the photos were taken by the film camera and digitized later. Some hints on selecting suitable calibration parameters are listed below:

- It is very unlikely that skew transformation coefficient will have non zero value. So its almost always safe to set skew parameter equal to zero.
- Unless you have used lenses with high distortion, such as fish eyes, the same applies to distortion coefficients. Leave it zero and PhotoScan will estimate them on its own. If ultra wide or fisheye lens were used to capture the photos you may try to estimate them using Agisoft Lens utility for lens calibration ([http://www.agisoft.ru/products/lens/](http://www.agisoft.ru/products/lens/)).
- $f_x$ and $f_y$ coefficients are normally equal. They may be different if the pixels of recording media were not square, which is a very rare case. If you know the focal length of the lens, physical dimension of the optical sensor and size of picture in pixels you may easily calculate these coefficients as: $f_x =$ focal length in mm * x-dimension of sensor in pixels / x-dimension of sensor in mm. Similar formula applies to $f_y$. 
• For conventional (non tilt and shift) lenses the optical axis of the lens is likely to intercept the optical sensor plane in its geometric center. So for $c_x$ and $c_y$ coefficient the coordinates of the image center would be the good guess.

**Automatic refinement of camera calibration parameters**

By default PhotoScan considers specified camera calibration parameters as the initial guess, and refines them later during the photo alignment. That is generally a desirable behaviour. However in the cases when the camera calibration is known precisely (like in case of a metric camera), it may be required to protect camera calibration parameters from optimization. To fix the camera calibration parameters select the Fix calibration check box in the Camera Calibration dialog.

**Using masks**

**Overview**

Masks are used in PhotoScan to specify the areas on the photos which can otherwise be confusing to the program or lead to incorrect reconstruction results. Masks can be applied at the following stages of processing:

- Alignment of the photos
- Building 3D model geometry
- Building 3D model texture
- Exporting Orthophoto

**Alignment of the photos**

Masked areas can be excluded during feature point detection. Thus, the objects on the masked parts of the photos are not taken into account while estimating camera positions. This is important in the setups, where the object of interest is not static with respect to the scene, like when using a turn table to capture the photos.

Masking may be also useful when the object of interest occupies only a small part of the photo. In this case a small number of useful matches can be filtered out mistakenly as a noise among a much greater number of matches between background objects.

**Building 3D model**

While building the model, masked areas are not used in the surface generation process. Masking can be used to reduce the resulting model complexity, by eliminating the areas on the photos that are not of interest.
Masked areas are always excluded from processing during surface reconstruction and texture generation stages.

Let's take for instance a set of photos of some object. Along with an object itself on each photo some background areas are present. These areas may be useful for more precise camera positioning, so it is better to use them while aligning the photos. However, impact of these areas at the building geometry stage is exactly opposite. If they are used for building geometry the resulting model will contain object of interest and its background. Background geometry will "consume" some part of mesh polygons that could be otherwise used for modeling the main object.

Setting the masks for such background areas allows to avoid this problem and increases the precision and quality of geometry reconstruction.

**Building texture atlas**
During texture atlas generation, masked areas on the photos are not used for texturing. Masking areas on the photos that are occluded by outliers or obstacles helps to prevent the "ghosting" effect on the resulting texture atlas.

**Editing masks**
Modification of the current mask is performed by adding or subtracting selections. A selection is created with one of the supported selection tools and is not incorporated in the current mask until it is merged with a mask using Add Selection or Subtract Selection operations.

**To edit the mask**
1. Open the photo to be masked by double clicking on its name on the Workspace / Photo / Ground Control pane. The photo will be opened in the main window. The existing mask will be displayed as a shaded region on the photo.
2. Select the desired selection tool and generate a selection.
3. Click on Add Selection toolbar button to add current selection to the mask, or Subtract Selection to subtract the selection from the mask. Invert Selection button allows to invert current selection prior to adding or subtracting it from the mask.

The following tools can be used for creating selections:

- **Rectangle selection tool**
  Rectangle selection tool is used to select large areas or to clean up the mask after other selection tools were applied.

- **Intelligent scissors tool**
  Intelligent scissors is used to generate a selection by specifying its boundary. The boundary is formed by selecting a sequence of vertices with a mouse, which are automatically connected with segments. The segments can be formed either by straight lines, or by curved contours snapped to the object boundaries. To enable snapping, hold Ctrl key while selecting the next vertex. To complete the selection, the boundary should be closed by clicking on the first boundary vertex.

- **Intelligent paint tool**
  Intelligent paint tool is used to "paint" a selection by the mouse, continuously adding small image regions, bounded by object boundaries.
Magic wand tool

Magic Wand tool is used to select uniform areas of the image. To make a selection with a Magic Wand tool, click inside the region to be selected.

The range of pixel colors selected by Magic Wand is controlled by the tolerance value. At lower tolerance values the tool selects fewer colors similar to the pixel you click with the Magic Wand tool. Higher value broadens the range of colors selected.

Note

- To add new area to the current selection hold the Ctrl key during selection of additional area.
- The masks are generated individually for each image. If some object should be masked out, it should be masked out on all photos, where that object appears.

Loading masks

Masks can be loaded from external sources, as well as generated automatically from background images if such data is available. PhotoScan supports loading masks from the following sources:

- From alpha channel of the source photos.
- From separate images.
- Generated from background photos based on background differencing technique.

To import masks

1. Select Import Masks... command from the Tools menu.
2. In the Import Mask dialog select suitable parameters. Click OK button when done.
3. When generating masks from separate or background images, the folder selection dialog will appear. Browse to the folder containing corresponding images and select it.
4. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

The following parameters can be specified during mask import:

Import masks for

- Current photo - load mask for the currently opened photo (if any).
- Active chunk - load masks for active chunk.
- Entire workspace - load masks for all chunks in the project.

Method

- Specifies the source of the mask data.
- From Alpha - load masks from alpha channel of the source photos.
Advanced use

From File - load masks from separate images.

From Background - generate masks from background photos.

Mask file names (not used in From alpha mode)
Specifies the file name template used to generate mask file names. This template can contain special tokens, that will be substituted by corresponding data for each photo being processed. The following tokens are supported:

{filename} - file name of the source photo without extension.

{fileext} - extension of the source photo.

{camera} - camera label.

{frame} - frame number.

{filenum} - sequential number of the mask being imported.

For example, {filename}_mask.png template can be used if masks are available in PNG format and have a _mask suffix.

Tolerance (From Background method only)
Specifies the tolerance threshold used for background differencing. Tolerance value should be set according to the color separation between foreground and background pixels. For larger separation higher tolerance values can be used.

Created masks can be also saved for external editing or storage.

To export masks

1. Select Export Masks... command from the Tools menu.

2. In the Export Mask dialog select suitable parameters. Click OK button when done.

3. Browse to the folder where the masks should be saved and select it.

4. The progress dialog box will appear displaying the current processing status. To cancel processing click Cancel button.

The following parameters can be specified during mask export:

Export masks for
Specifies whether masks should be exported for the currently opened photo, active chunk or entire Workspace.

Current photo - save mask for the currently opened photo (if any).

Active chunk - save masks for active chunk.

Entire workspace - save masks for all chunks in the project.

File type
Specifies the type of generated files.

Single channel mask image - generates single channel black and white mask images.
**Advanced use**

Image with alpha channel - generates color images from source photos combined with mask data in alpha channel.

**Mask file names**
Specifies the file name template used to generate mask file names. This template can contain special tokens, that will be substituted by corresponding data for each photo being processed. The following tokens are supported:

- `{filename}` - file name of the source photo without extension.
- `{fileext}` - extension of the source photo.
- `{camera}` - camera label.
- `{frame}` - frame number.
- `{filenum}` - sequential number of the mask being exported.

For example, `{filename}_mask.png` template can be used to export masks in PNG format with `_mask` suffix.

- **Note**
  - When importing/exporting mask for the current photo only, PhotoScan will prompt for the actual image instead of image folder. Mask file names parameter will not be used in this case.

**Editing sparse point cloud**

The following point cloud editing tools are available in PhotoScan:

- Automatic filtering based on specified criterion
- Manual points removal

- **Note**
  - Point cloud editing operation can be undone/redone using Undo/Redo command from the Edit menu.

**Filtering points based on specified criterion**

In some cases it may be useful to find out where the points with high reprojection error are located within the cloud, or remove points representing high amount of noise. Point cloud filtering helps to select such points, which usually are supposed to be removed.

PhotoScan supports the following criteria for filtering point cloud:

**Reprojection error**
High reprojection error usually indicates poor localization accuracy of the corresponding point projections at the point matching step. It is also typical for false matches. Removing such points can improve accuracy of the subsequent optimization step.

**Reconstruction uncertainty**
High reconstruction uncertainty is typical for points, reconstructed from nearby photos with small baseline. Such points can noticeably deviate from the object surface, introducing noise in the point
cloud. While removal of such points should not affect the accuracy of optimization, it may be useful to remove them before building geometry in Point Cloud mode or for better visual appearance of the point cloud.

**To remove points based on specified criterion**

1. Switch to Point Cloud view mode using Point Cloud toolbar button.

2. Select Gradual Selection... command from the Edit menu.

3. In the Gradual Selection dialog box specify the criterion to be used for filtering. Adjust the threshold level using the slider. You can observe how the selection changes while dragging the slider. Click OK button to finalize the selection.

4. To remove selected points use Delete Selection command from the Edit menu or click Delete Selection toolbar button (or simply press Del button on the keyboard).

**Manual points removal**

Incorrect points can be also removed manually.

**To remove points from the sparse cloud manually**

1. Switch to Point Cloud view mode using Point Cloud toolbar button.

2. Select points to be removed using Rectangle Selection or Circle Selection tools. To add new points to the current selection hold the Ctrl key during selection of additional points. To remove some points from the current selection hold the Shift key during selection of points to be removed.

3. To delete selected points click the Delete Selection toolbar button or select Delete Selection command from the Edit menu. To crop selection to the selected points click the Crop Selection toolbar button or select Crop Selection command from the Edit menu.

**Editing model geometry**

The following mesh editing tools are available in PhotoScan:

- Decimation tool
- Connected component filtering
- Manual face removal

More complex editing can be done in the external 3D editing tools. PhotoScan allows to export mesh and then import it back for this purpose.

**Note**

- For face removal operations such as manual face removal and connected component filtering it is possible to undo the last mesh editing operation. There are Undo/Redo commands in the Edit menu.
Please note that undo/redo commands are not supported for mesh decimation and this operation can not be undone.

**Decimation tool**

Decimation is a tool used to decrease the geometric resolution of the model by replacing high resolution mesh with a lower resolution one, which is still capable of representing the object geometry with high accuracy. PhotoScan tends to produce 3D models with excessive geometry resolution, so mesh decimation is usually a desirable step after geometry computation.

The high detailed models may contain hundreds of thousands polygons. While it is acceptable to work with such a complex models in 3D editor tools, in most conventional tools like Adobe Reader or Google Earth high complexity of 3D models may noticeably decrease application performance. High complexity also results in longer time required to build texture and to export model in pdf file format.

In some cases it is desirable to keep as much geometry details as possible like it is needed for scientific and archive purposes. However, if there are no special requirements it is recommended to decimate the model down to 100 000 - 200 000 polygons for exporting in PDF, and to 100 000 or even less for displaying in Google Earth and alike tools.

**To decimate 3D model**

1. Select Decimate Mesh... command from the Tools menu.
2. In the Decimate Mesh dialog box specify the target number of faces, which should remain in the final model. Click on the OK button to start decimation.
3. The progress dialog box will appear displaying the current processing status. To cancel processing click on the Cancel button.

**Note**

- Texture atlas is discarded during decimation process. You will have to rebuild texture atlas after decimation is complete.

**Connected component filtering**

In some cases reconstructed geometry may contain the cloud of small isolated mesh fragments surrounding the "main" model. Connected component filtering helps to remove small isolated mesh fragments, which are usually reconstructed incorrectly or are not needed.

**To remove small isolated mesh fragments**

1. Select Gradual Selection... command from the Edit menu.
2. In the Gradual Selection dialog box select the size of isolated components to be removed using the slider. You can observe how the selection changes while dragging the slider. Click OK button to finalize the selection.
3. To remove the selected components use Delete Selection command from the Edit menu or click Delete Selection toolbar button (or simply press Del button on the keyboard).

Note that PhotoScan always selects the fragments starting from the smallest ones. If the model contains only one component the selection will be empty.
Advanced use

Manual face removal

Unnecessary and excessive sections of model geometry can be also removed manually.

To remove part of the faces manually

1. Select rectangle or circle selection tool using Rectangle Selection or Circle Selection toolbar buttons.
2. Make the selection using the mouse. To add new faces to the current selection hold the Ctrl key during selection of additional faces. To remove some faces from the current selection hold the Shift key during selection of faces to be removed.
3. To delete selected faces click the Delete Selection toolbar button or use Delete Selection command from the Edit menu. To crop selection to the selected faces click the Crop Selection toolbar button or use Crop Selection command from the Edit menu.

To grow or shrink current selection

1. To grow current selection press PageUp key in the selection mode. To grow selection by even a larger amount, press PageUp while holding Shift key pressed.
2. To shrink current selection press PageDown key in the selection mode. To shrink selection by even a larger amount, press PageDown while holding Shift key pressed.

Editing mesh in the external program

To export mesh for editing in the external program

1. Select Export Model... command from the File menu.
2. In the Save As dialog box, specify the desired mesh format in the Save as type combo box. Select the file name to be used for the model and click Save button.
3. In the opened dialog box specify additional parameters specific to the selected file format. Click OK button when done.

To import edited mesh

1. Select Import Mesh... command from the Tools menu.
2. In the Open dialog box, browse to the file with the edited model and click Open.

Note

- PhotoScan supports loading models in Wavefront OBJ and Stanford PLY file formats only. Please make sure to select one of these file formats when exporting model from the external 3D editor.

Setting coordinate system

Many applications require data with a defined coordinate system. Setting the coordinate system also provides a correct scaling of the model allowing for surface area and volume measurements and makes
model loading in geoviewers and geoinformatics software much easier. Some functionality like digital elevation model export is available only after the coordinate system is defined.

PhotoScan supports setting a coordinate system based on either ground control point (marker) coordinates or camera coordinates. In both cases the coordinates are specified in the Ground Control pane and can be either loaded from the external file or typed in manually.

Setting coordinate system based on recorded camera positions is often used in aerial photography processing. However it may be also useful for processing photos captured with GPS enabled cameras. Placing markers is not required if recorded camera coordinates are used to initialize the coordinate system.

In the case when ground control points are used to set up the coordinate system the markers should be placed in the corresponding locations of the scene.

Using camera positioning data for georeferencing the model is faster as manual marker placement is not required. On the other hand, ground control point coordinates are usually more accurate than telemetry data, allowing for more precise georeferencing.

**Placing markers**

PhotoScan uses markers to specify locations within the scene. Markers are used for setting up a coordinate system, measuring distances within the scene as well as for marker based chunk alignment. Marker positions are defined by their projections on the source photos. The more photos are used to specify marker position the higher is accuracy of marker placement. To define marker location within a scene it should be placed on at least 2 photos.

**Note**

- Marker placement is not required for setting the coordinate system based on recorded camera coordinates. This section can be safely skipped if the coordinate system is be defined based on recorded camera locations.

PhotoScan supports two approaches to marker placement: manual marker placement and guided marker placement. In the manual approach the marker projections should be specified manually for each photo where the marker is visible. Manual marker placement doesn't require 3D model and can be performed even before photo alignment.

In the guided approach the marker projection is specified for the single photo only. PhotoScan automatically projects the corresponding ray onto the model surface and calculates marker projections on the remaining photos. Marker projections defined automatically on individual photos can be further refined manually. Reconstructed 3D model surface is required for the guided approach.

Guided marker placement usually speeds up the procedure of marker placement significantly and also reduces the chance of incorrect marker placement. It is recommended in most cases unless there are any specific reasons preventing this operation.

**To place a marker using guided approach**

1. Open the photo where the marker is visible by double clicking on its name.
2. Switch to the marker editing mode using Edit Markers toolbar button.
3. Right click on the photo at the point corresponding to the marker location.
4. Select Create Marker command from the context menu. New marker will be created and its projections on the other photos will be automatically defined.
**Advanced use**

Note

- If the 3D model is not available or the ray at the selected point does not intersect with the model surface, the marker projection will be defined on the current photo only.

- Guided marker placement can be performed in the same way from the 3D view by clicking on the corresponding point on the model surface using Create Marker tool. While the accuracy of marker placement in the 3D view is usually much lower, it may be still useful for quickly locating the photos observing the specified location on the model. To view the corresponding photos use Filter by Markers button from the Photo pane toolbar.

To place a marker using manual approach

1. Create marker instance using Add Marker command from the Chunk context menu (available by right clicking on the chunk title on the Workspace pane).

2. Open the photo where the marker projection needs to be added by double clicking on the photos name.

3. Switch to the marker editing mode using Edit Markers toolbar button.

4. Right click on the photo where the marker projection needs to be placed. From the context menu open Place Marker submenu and select the marker instance previously created. The marker projection will be added to the current photo.

5. Repeat the previous step to place marker projections on other photos if needed.

Note

- If a marker has been placed on at least two aligned images PhotoScan will find the marker projections on the rest of the photos. The calculated marker positions will be indicated with icon on the corresponding aligned photos in Photo View mode.

Defined marker locations can be later refined manually by dragging their projections on the corresponding photos.

To refine marker location

1. Open the photo where the marker is visible by double clicking on the photos name.

2. Switch to the marker editing mode using Edit Markers toolbar button.

3. Move the marker projection to the desired location by dragging it using left mouse button.

Note

- To list the photos where the marker locations are defined, select the corresponding marker on the Workspace pane. The photos where the marker is placed will be marked with a icon on the Photos pane.

PhotoScan automatically assigns default labels for each newly created marker. These labels can be changed using the Rename... command from the marker context menu.
Assigning reference coordinates

To reference the model the real world coordinates of at least 3 points of the scene should be specified. Depending on the requirements, the model can be referenced using marker coordinates, camera coordinates, or both. Real world coordinates used for referencing the model along with the type of coordinate system used are specified using the Ground Control pane.

The model can be located in either local Euclidean coordinates or in georeferenced coordinates. For model georeferencing a wide range of various geographic and projected coordinate systems are supported, including widely used WGS84 coordinate system. Besides, almost all coordinate systems from the EPSG registry are supported as well.

Reference coordinates can be specified in one of the following ways:

- Loaded from a separate text file (using character separated values format).
- Entered manually in the Ground Control pane.
- Loaded from GPS EXIF tags (if present).

To load reference coordinates from a text file

1. Click Import toolbar button on the Ground Control pane. (To open Ground Control pane use Ground Control command from the View menu.) Browse to the file containing recorded reference coordinates and click Open button.
2. In the Import CSV dialog select the delimiter and indicate the number of the data column for each coordinate. Indicate columns for the orientation data if present.
3. Click OK button. The reference coordinates data will be loaded onto the Ground Control pane.

Note

- In the data file columns and rows are numbered starting from 0.
- If reference coordinates of a marker / camera position for a photo are not specified in the loading file the current value will be kept for them.
- An example of a coordinates data file in the CSV format is given in the next section.

To assign reference coordinates manually

1. Switch to the View Source mode using View Source button from the Ground Control pane toolbar. (To open Ground Control pane use Ground Control command from the View menu.)
2. On the Ground Control pane double click on x/y/z cells to assign values to corresponding coordinates.
3. Repeat for every marker / camera position needed to be specified.
4. To remove unnecessary reference coordinates select corresponding items from the list and press Del key.
5. Click Update toolbar button to apply changes and set coordinates.
To load reference coordinates from GPS EXIF tags

1. Open Ground Control pane using Ground Control... command from the View menu.
2. Click Import EXIF toolbar button. The reference coordinates data will be loaded into the Ground Control pane.

After reference coordinates have been assigned PhotoScan automatically estimates coordinates in a local Euclidian system and calculates the referencing errors. To see the results switch to the View Estimated or View Errors modes respectively using View Estimated and View Errors toolbar buttons. The largest error will be highlighted.

To set a georeferenced coordinate system

1. Assign reference coordinates using one of the options described above.
2. Click Settings button on the Ground Control pane toolbar.
3. In the Ground Control Settings dialog box select the Coordinate System used to compile reference coordinates data.
4. Specify the assumed measurement accuracy.
5. Indicate relative camera to GPS system coordinates if present in Camera Correction section of the Ground Control Settings dialog box.
6. Click OK button to initialize the coordinate system and estimate geographic coordinates.

**Note**

- In Select Coordinate System dialog it is possible to ease searching for the required georeferencing system using Filter option. Enter respective EPSG (e.g. EPSG::4302) code to filter the systems.
- Step 5 can be safely skipped if you are using standard GPS system (not that of superhigh precision).

To view the estimated geographic coordinates and reference errors switch between the View Estimated and View Errors modes respectively using View Estimated and View Errors toolbar buttons. The largest error will be highlighted. A click on the column name on the Ground Control pane sorts the markers and photos by the data in the column. At this point you can review the errors and decide whether additional refinement of marker locations is required (in case of marker based referencing), or if certain reference points should be excluded.

To save the errors and / or estimated coordinates use Export toolbar button on the Ground Control pane.

To reset a chunk georeferencing use Reset Transform command from the chunk context menu on the Workspace pane. [R] indicator of a chunk being georeferenced will be removed from the chunk name.

**Note**

- Unchecked reference points on the Ground Control pane are not used for georeferencing. Use context menu to check / uncheck selected items.
• After adjusting marker locations on the photos, the coordinate system will not be updated automatically. It should be updated manually using Update toolbar button on the Ground control pane.

• PhotoScan allows to convert the estimated geographic coordinates into a different coordinate system. To calculate the coordinates of the camera positions and / or markers in a different coordinate system use Convert toolbar button on the Ground Control pane.

**Example of a reference coordinates file in CSV format**

The reference coordinates can be loaded onto the Ground Control pane using character separated text file format. Each reference point is specified in this file on a separate line. Sample reference coordinates file is provided below:

<table>
<thead>
<tr>
<th>#</th>
<th>&lt;label&gt;</th>
<th>&lt;x&gt;</th>
<th>&lt;y&gt;</th>
<th>&lt;z&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IMG_0159.JPG</td>
<td>40.165011</td>
<td>48.103654</td>
<td>433.549477</td>
</tr>
<tr>
<td></td>
<td>IMG_0160.JPG</td>
<td>40.165551</td>
<td>48.103654</td>
<td>434.724281</td>
</tr>
<tr>
<td></td>
<td>IMG_0161.JPG</td>
<td>40.166096</td>
<td>48.103640</td>
<td>435.630558</td>
</tr>
</tbody>
</table>

Individual entries on each line should be separated with a tab (space, semicolon, comma, etc) character. All lines starting with # character are treated as comments.

Records from the coordinate file are matched to the corresponding photos or markers basing on the label field. Camera coordinates labels should match the file name of the corresponding photo including extension. Marker coordinates labels should match the labels of the corresponding markers in the project file. All labels are case insensitive.

**Note**

• Character separated reference coordinates format doesn’t include specification of the type of coordinate system used. The kind of coordinate system used should be selected separately.

**Optimizing photo alignment**

PhotoScan estimates internal and external camera orientation parameters during photo alignment. This estimation is performed using image data alone, and there may be some errors in the final estimates. The accuracy of the final estimates depends on many factors, like overlap between the neighboring photos, as well as on the shape of the object surface. These errors can lead to non-linear deformations of the final model.

During georeferencing the model is linearly transformed using 7 parameter similarity transformation (3 parameters for translation, 3 for rotation and 1 for scaling). Such transformation can compensate only a linear model misalignment. The non-linear component can’t be removed with this approach. This is usually the main reason of georeferencing errors.

The possible non-linear deformations of the model can be removed by optimizing the estimated point cloud and camera parameters based on the known reference coordinates. During this optimization PhotoScan adjusts estimated point coordinates and camera parameters minimizing the sum of reprojection error and reference coordinate misalignment error.
To achieve greater optimizing results it may be useful to edit sparse point cloud deleting obviously mislocated points beforehand. To read about point cloud editing refer to the Editing sparse point cloud section of the manual.

The georeferencing accuracy can be improved significantly after optimization. It is recommended to perform optimization if the final model will be used for any kind of measurements.

**To optimize photo alignment**

1. Set the camera and / or marker coordinates to be used for optimization (if not done yet).

2. Click Settings toolbar button on the Ground Control pane and set the coordinate system (if not done yet).

3. In the Ground Control Settings dialog box specify the assumed accuracy of ground control measurements, as well as the assumed accuracy of marker projections on the source photos.

4. Indicate relative camera to GPS system coordinates if present in Camera Correction section of the Ground Control Settings dialog box.

5. Click OK button.

6. Click Optimize toolbar button. In Optimize Photo Alignment dialog box check additional camera parameters to be optimized if needed. Click OK button to start optimization.

7. After the optimization is complete, the georeferencing errors will be updated.

**Note**

- Step 4 can be safely skipped if you are using standard GPS system (not that of superhigh precision).
- The model data (if any) is cleared by the optimization procedure. You will have to rebuild the model geometry after optimization.
- When performing optimization based on marker coordinates, a 0 accuracy can be specified for marker coordinates. In this case PhotoScan will assume that marker coordinates are known exactly, and will exclude their real coordinates from the optimization procedure. This can help to obtain more accurate results when marker coordinates are measured with high accuracy.

**Performing measurements**

PhotoScan supports measurement of distances between control points, as well as surface area and volume of the reconstructed 3D model.

**Distance measurement**

The distance measurement tool enables measurements of direct distances between the points of the reconstructed 3D scene. The points used for distance measurement, as well as setting the reference distance, must be defined by placing markers in the corresponding locations. The reference distance or model coordinate system must be also initialized before the distance measurements can be performed.

For instructions on placing the markers, refining their positions and setting coordinate system please refer to the Setting coordinate system section of the manual.
Advanced use

To set reference distance

1. Place markers in the scene at the points with the known distance between them.
2. Select the Set Reference Distance tool using the corresponding toolbar button.
3. Click on the pair of markers with the known distance inbetween.
4. In the Set Reference Distance dialog box specify the distance between the points. Click OK button to set the reference distance.

The scale of the model will be determined and it will be possible to measure distance between other points of the model.

Note

- The initial distance displayed in the Set Reference Distance dialog box corresponds to the distance calculated basing on previously defined scale. Setting new reference distance resets previously defined model scale and / or coordinate system.

To measure distance

1. Place the markers in the scene at the locations to be used for distance measurement.
2. Select the Measure Distance tool using the corresponding toolbar button.
3. Click on the pair of markers to be used for distance measurements.
4. The distance between the selected markers will be displayed in the Measure Distance dialog box.

Note

- The distance values measured by PhotoScan are displayed in meters.

Surface area and volume measurement

Surface area or volume measurements of the reconstructed 3D model can be performed only after the scale or coordinate system of the scene is defined. For instructions on setting coordinate system please refer to the Setting coordinate system section of the manual.

To measure surface area and volume

1. Select Measure Area and Volume... command from the Tools menu.
2. The model surface area and volume will be displayed in the Measure Area and Volume dialog box. Surface area is measured in square meters, while mesh volume is measured in cubic meters.

Volume measurement can be performed only for the models with closed geometry. If there are any holes in the model surface PhotoScan will report zero volume. Existing holes in the mesh surface can be filled in before performing volume measurements using Close Holes... command from the Tools menu.

Note

- If coordinate system is not defined for the model PhotoScan will allow to calculate area and volume of the model. However, the values obtained will be absolutely meaningless as the unit of measurement is not defined.
Multispectral imagery

PhotoScan supports processing of multispectral images saved as multichannel (single page) TIFF files. The main processing stages for multispectral images are performed based on the master channel, which can be selected by the user. During orthophoto export, all spectral bands are processed together to form a multispectral orthophoto with the same bands as source images.

The overall procedure for multispectral imagery processing does not differ from the usual procedure for normal photos, except the additional master channel selection step performed after adding images to the project. For best results it is recommended to select the spectral band which is sharp and detailed as much as possible.

To select master channel

1. Add multispectral images to the project using Add Photos... command from the Workflow menu or Add Photos toolbar button.
2. Select Set Master Channel... command from the chunk context menu in the Workspace pane.
3. In the Set Master Channel dialog select the channel to be used as master and click OK button. Display of images in PhotoScan window will be updated according to the master channel selection.

Note

• Multispectral orthophoto export is supported in GeoTIFF format only. When exporting in other formats, only master channel will be saved.

4D processing

Overview

PhotoScan supports reconstruction of dynamic scenes captured by a set of statically mounted synchronized cameras. For this purpose multiple image frames captured at different time moments can be loaded for each camera location, forming a multiframe chunk. In fact normal chunks capturing a static scene are multiframe chunks with only a single frame loaded. Navigation through the frame sequence is performed using Timeline pane.

Although a separate static chunk can be used to process photos for each time moment, using aggregate multiframe chunks has several advantages:

• Coordinate systems for individual frames are guaranteed to match. There is no need to align chunks to each other after processing.

• Each processing step can be applied to the entire sequence, with a user selectable frame range. There is no need to use batch processing, which simplifies the workflow.

• Accuracy of photo alignment is better due to the joint use of photos from the entire sequence.

• Markers can be tracked automatically through the sequence.

• Built-in support makes navigation through the sequence simple and intuitive.
Multiframe chunks can be also efficient (with some limitations) for processing of unordered photo sets of the same object or even different objects, provided that cameras remain static throughout the sequence.

**Managing multiframe chunks**

Multiframe layout is formed at the moment of adding photos to the chunk. It will reflect the data layout used to store image files. Therefore it is necessary to organize files on the disk appropriately in advance. The following data layouts can be used with PhotoScan:

a. All frames from corresponding camera are contained in a separate subfolder. The number of subfolders is equal to the number of cameras.

b. Corresponding frames from all cameras are contained in a separate subfolder. The number of subfolders is equal to the number of frames.

c. All frames from corresponding camera are contained in a separate multilayer image. The number of multilayer images is equal to the number of cameras.

d. Corresponding frames from all cameras are contained in a separate multilayer image. The number of multilayer images is equal to the number of frames.

Once the data is properly organized, it can be loaded into PhotoScan to form a multiframe chunk. The exact procedure will depend on whether the multifolder layout (variants a and b) or multilayer (variants c and d) layout is used.

**To create a chunk from multifolder layout**

1. Select Add Folder... command from the Workflow menu.

2. In the Add Folder dialog box browse to the parent folder containing subfolders with images. Then click Select Folder button.

3. In the Add Photos dialog select the suitable data layout. For layout a) above select "Create multiframe cameras from folders as cameras". For layout b) select "Create multiframe cameras from folders as frames".

4. Created multiframe chunk will appear on the Workspace pane.

**To create a chunk from multilayer images**

1. Select Add Photos... command from the Workflow menu or click Add Photos toolbar button.

2. In the Add Photos dialog box browse to the folder containing multilayer images and select files to be processed. Then click Open button.

3. In the Add Photos dialog select the suitable data layout. For layout c) above select "Create multiframe cameras from files as cameras". For layout d) select "Create multiframe cameras from files as frames".

4. Created multiframe chunk will appear on the Workspace pane.

It is recommended to inspect the loaded frame sequence for errors. This can be done by scrolling the frame selector in the Timeline pane and inspecting thumbnails in the Photos pane during scrolling.

After multiframe chunk is created, it can be processed in the same way as normal chunks. For multiframe chunks additional processing parameters allowing to select the range of frames to be processed will be provided where appropriate.
Tracking markers

PhotoScan allows to automatically track marker projections through the frames sequence, provided that object position doesn't change significantly between frames. This greatly simplifies the task of labeling of a moving point if the number of frames is large.

To track markers through the frame sequence

1. Scroll frame selector in the Timeline pane to the 1st frame. Add markers for the 1st frame as described in the Setting coordinate system section.
2. Select Track Markers... command from the Tools menu.
3. Adjust the starting and ending frame indices if necessary. Default values correspond to tracking from the current frame to the end of sequence. Click OK button to start tracking.
4. Check tracked marker locations. In case of an error at some frame, adjust the wrong marker location at the frame where the failure occurred and restart tracking from that frame using Track Markers... command again.

Note

• If the ending frame index is smaller than the starting index, tracking will be performed in the backwards direction.

• Automatic marker tracking will likely fail in case when structured light is used to add texture details to the object surface, as the light pattern will not be static with respect to the moving object surface.

Python scripting

PhotoScan supports Python API, using Python 3.2 as a scripting engine.

Python commands and scripts can be executed in PhotoScan through one of the following options:

• PhotoScan Console pane can serve as standard Python console;

• Click Run Script button on Console pane toolbar or use Run Script... command from the Tools menu to run a Python script.

For details on PhotoScan functionality accessible through Python scripts please refer to Python API Reference document available on AgiSoft official website (http://www.agisoft.ru/products/photoscan/professional/).
Appendix A. Graphical User Interface

Application Window

Model view

Model view tab is used for displaying 3D data as well as for 3D model and point cloud editing. The view of the model depends on the current processing stage and is also controlled by mode selection buttons on the PhotoScan toolbar.

Model can be shown in textured, solid, shaded, or wireframe mode. Along with the model the results of photo alignment can be displayed. These include point cloud and camera positions for each photo.

PhotoScan supports the following tools for navigation in the 3D view:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Keyboard modifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotation Tool</td>
<td>Default</td>
</tr>
<tr>
<td>Pan Tool</td>
<td>Ctrl key pressed</td>
</tr>
<tr>
<td>Zooming Tool</td>
<td>Shift key pressed</td>
</tr>
</tbody>
</table>

All navigation tools are accessible in the navigation mode only. To enter the navigation mode click the Navigation toolbar button.
Graphical User Interface

Note

• Zooming into the model can be also controlled by the mouse wheel.

Photo view

Photo view tab is used for displaying individual photos as well as masks and markers on them.

Photo view is visible only if any photo is opened. To open the photo double-click on its name on the Workspace, Ground Control, or Photos pane.

Workspace pane

On the Workspace pane all elements comprising the current project are displayed. These elements can include:

• List of chunks in the project
• List of cameras in each chunk
• List of markers in each chunk
• 3D models in separate chunks

Buttons located on the pane toolbar allow:

• Add chunks
• Add photographs
• Add markers
• Enable or disable certain photographs or chunks for processing at further stages.
• Remove items

Each element in the list is linked with the context menu providing quick access to some common operations.

Photos pane

Photos pane displays the list of photos / masks / depth maps in the active chunk in the form of thumbnails.

Buttons located on the pane toolbar allow:

• Add cameras
• Enable / disable certain cameras
• Remove cameras
• Increase / decrease icons' size
• Switch between types of thumbnailing images
• Filter cameras by feature points or by markers
Console pane

Console pane is used for:

- Displaying auxiliary information
- Displaying error messages
- Python commands

Buttons located on the pane toolbar allow:

- Save log
- Clear log
- Execute Python script

Ground Control pane

Ground Control pane is designed for:

- Displaying camera and / or markers coordinates
- Displaying camera orientation
- Displaying estimation errors

Buttons located on the pane toolbar allow:

- Import / export reference coordinates
- Convert reference coordinates from one system to the other
- Indicate coordinate system and measurement accuracy to be assumed through Settings dialog
- Optimize estimation and update data
- Switch between source coordinates, estimated coordinates, and errors views

Timeline pane

Timeline pane is designed for:

- Working with multi-frame chunks

Buttons located on the pane toolbar allow:

- Add / remove frames from chunk
- Play / stop frame sequence
- Adjust frame rate through Settings dialog

Note

- To open any pane select a corresponding command from the View menu.
Menu Commands

File Menu

- New
  Creates an empty PhotoScan project.

- Open...
  Opens PhotoScan project file.

- Append...
  Appends existing PhotoScan project file to the current one.

- Save
  Saves PhotoScan project file.

- Save As...
  Saves PhotoScan project file with a new name.

- Export Model...
  Saves 3D model.

- Export Points...
  Saves sparse / dense point cloud.

- Export Orthophoto...
  Generates orthophoto based on the reconstructed geometry.

- Export DEM...
  Generates digital elevation model based on the reconstructed geometry.

- Generate Report...
  Generates PhotoScan processing report in pdf format.

- Exit
  Quits the application. Prompts to save active project.

Edit Menu

- Undo
  Undo the last editing operation.

- Redo
  Redo the previously undone editing operation.

- Delete Selection
  Removes selected faces from the mesh or selected points from the point cloud.

- Crop Selection
  Crops selected faces / points.

- Invert Selection
  Inverts current selection.

- Grow Selection
  Grows current selection.

- Shrink Selection
  Shrinks current selection.

- Gradual selection...
  Selects faces/points based on the specified criterion.

View Menu

- Point Cloud
  Displays sparse point cloud reconstructed during photo alignment.

- Shaded
  Displays 3D model in the shaded mode.

- Solid
  Displays 3D model in the solid mode.
**Graphical User Interface**

### View Menu
- **Wireframe**
  - Displays 3D model in the wireframe mode.
- **Textured**
  - Displays 3D model in the textured mode.
- **Show Cameras**
  - Shows or hides camera positions estimated during image alignment.
- **Show Trackball**
  - Shows or hides the trackball.
- **Show Info**
  - Shows or hides the mesh information on-screen display.
- **Perspective/Orthographic**
  - Switches visualisation view between Perspective and Orthographic.
- **Workspace**
  - Shows or hides Workspace pane.
- **Timeline**
  - Shows or hides Timeline pane.
- **Ground Control**
  - Shows or hides Ground Control pane.
- **Photos**
  - Shows or hides Photos pane.
- **Console**
  - Shows or hides Console pane.

### Workflow Menu
- **Add Photos...**
  - Loads additional photos to be processed by PhotoScan.
- **Add Folder...**
  - Loads additional photos from folders to be processed by PhotoScan.
- **Align Photos...**
  - Generates camera positions and sparse point cloud.
- **Build Geometry...**
  - Generates 3D model geometry.
- **Build Texture...**
  - Generates 3D model texture.
- **Align Chunks**
  - Aligns multiple chunks.
- **Merge Chunks**
  - Merges multiple chunks into the single model.
- **Batch Process...**
  - Opens Batch Process dialog box.

### Tools Menu
- **Decimate Mesh...**
  - Decimates mesh to the target face count.
- **Close Holes...**
  - Closes holes on the model surface.
- **Track markers...**
  - Tracks marker locations across the frame sequence.
- **Import Mesh...**
  - Imports edited mesh from the external program.
- **Import Texture...**
  - Imports edited texture from the external program.
Graphical User Interface

Tools Menu

Import Cameras... Imports camera positions and orientation data.
Import Masks... Imports masks or creates mask from alpha channel.
Export Texture... Exports model texture.
Export Cameras... Exports camera positions and orientation data.
Export Mask... Exports masks templates.
Undistort Photos... Removes nonlinear distortions by warping source photos.
Set Reference Distance... Sets model scale based on the reference distance.
Measure Distance... Distance measurement tool.
Measure Area and Volume... Displays surface area and volume of the model.
View EXIF Data... Displayes EXIF data for the photos in the active chunk.
View Matches... Displays matches for the photos in the active chunk.
View Mesh Statistics... Collects and displays mesh statistics.
Camera Calibration... Shows camera calibration dialog box.
Preferences... Shows preferences dialog box.
Run Script... Opens Python Run Script dialog box.

Photo Menu

Navigation Switches to navigation mode.
Rectangle Selection Rectangle selection tool.
Intelligent Scissors Intelligent Scissors selection tool.
Intelligent Paint Intelligent Paint selection tool.
Magic Wand Magic Wand selection tool.
Edit Markers Switches to marker editing model.
View Points Shows detected features used for alignment of the current photo.
Add Selection Adds current selection to the mask.
Subtract Selection Subtracts current selection from the mask.
Invert Selection Inverts current selection.
Reset Mask... Resets mask for the current photo.
Graphical User Interface

**Photo Menu**
- ☀ Turn Shading On/Off
  
  Turns mask shading on or off.

**Help Menu**
- 📚 Contents
  
  Displays help contents.
- Check for Updates...
  
  Checks if PhotoScan update is available for download.
- Activate Product...
  
  Activates / deactivates the product using the activation key.
- 🤔 About PhotoScan...
  
  Displays program information, version number and copyright.

**Toolbar Buttons**

**General commands**
- 🌟 New
  
  Creates a new PhotoScan project file.
- 📥 Open
  
  Opens a PhotoScan project file.
- 📡 Save
  
  Saves a PhotoScan project file.

**3D view commands**
- 🌍 Navigation
  
  Navigation tool.
- 🔍 Rectangle Selection
  
  Rectangle selection tool.
- 🔘 Circle Selection
  
  Circle selection tool.
- 🔢 Resize region
  
  Volume selection tool.
- 🔄 Rotate Region
  
  Volume rotation tool.
- 🚚 Create Marker
  
  Marker placement tool.
- 🔜 Set Reference Distance
  
  Defines reference distance.
- 🔜 Measure Distance
  
  Distance measurement tool.
- ✗ Delete Selection
  
  Removes selected faces / points.
- 🔞 Crop Selection
  
  Crops selected faces / points.
- ⬅️ Undo
  
  Undo the last editing operation.
- ⬇️ Redo
  
  Redo the previously undone editing operation.

**3D view settings**
- 🔗 Point Cloud
  
  Shows / hides sparse point cloud reconstructed during image alignment.
3D view settings

- **Shaded**: Displays 3D model in the shaded mode.
- **Solid**: Displays 3D model in the solid mode.
- **Wireframe**: Displays 3D model in the wireframe mode.
- **Textured**: Displays 3D model in the textured mode.
- **Show Cameras**: Shows / hides camera positions, reconstructed during image alignment.
- **Show Aligned Chunks**: Shows / hides aligned chunks.
- **Reset View**: Resets model view.

Photo view commands

- **Navigation**: Switches to the navigation mode.
- **Rectangle Selection**: Rectangle selection tool.
- **Intelligent Scissors**: Intelligent scissors tool.
- **Intelligent Paint**: Intelligent paint tool.
- **Magic Wand**: Magic wand tool.
- **Edit Markers**: Switches to marker editing mode.
- **View Points**: Shows / hides feature points used for alignment of the photo.
- **Add Selection**: Adds current selection to the mask.
- **Subtract Selection**: Subtracts current selection from the mask.
- **Invert Selection**: Inverts current selection.
- **Undo**: Undo the last mask editing operation.
- **Redo**: Redo the previously undone mask editing operation.
- **Rotate Right**: Rotates the photo clockwise.
- **Rotate Left**: Rotates the photo counterclockwise.
- **Zoom In**: Increases magnification.
- **Zoom Out**: Decreases magnification.
- **Turn Shading On/Off**: Turns mask shading on or off.
Appendix B. Troubleshooting

Photo alignment succeeds, but the resulting camera positions appear to be wrong

The main reasons for the wrong photo alignment are listed below:

- Small overlap between the photos
- Object movement against the background scene
- Insufficient number of object surface details captured by the camera
- Strong blur or noise on the source photos

To obtain more information about the reason for alignment failure for the specific dataset it may be helpful to inspect feature points used for alignment of the photos as seen by the PhotoScan algorithms.

To inspect feature points used for alignment

1. Open the photo to be inspected by double-clicking on its name on the Workspace pane. The photo will be displayed in the main window.

2. Switch to the point view mode using View Points toolbar button. The points used for alignment of the photo will be overlayed on the image.

Depending on the observed point placement the following recommendations may help to solve the problem:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible reason</th>
<th>Recommended solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not enough points were used.</td>
<td>Low image quality or too small photo overlap.</td>
<td>Try making better photos with a better camera placement. Pay attention to the camera settings, like proper level of ISO. Use a tripod if required. Setting a proper lighting may be also helpful to capture higher amount of surface details.</td>
</tr>
<tr>
<td>The majority of points used belong to the background objects.</td>
<td>The object was not static during capturing or occupies only a small area on the photos.</td>
<td>Mask out background regions or consider shooting another photo set so that the object spans significant area on the photos. If masking of the background areas is used, make sure that Constrain features by mask option in the Align Photos dialog box is checked.</td>
</tr>
</tbody>
</table>

Reconstructed geometry appears to be cut and some important parts are missing

Usually this indicates that a wrong reconstruction volume was selected. By default PhotoScan uses an automatic reconstruction volume selection algorithm, which can produce undesirable selections in some cases. All object parts outside of the selected reconstruction volume are cropped and are not included in
Troubleshooting

the final model. Too large reconstruction volume selections are also undesirable as they result in longer processing time and greater memory consumption.

To overcome this problem a manual reconstruction volume selection tool should be used.

Note

• The photos must be aligned before the reconstruction volume can be defined.

To select the reconstruction volume manually

1. Select the manual reconstruction volume selection tool using Select Volume toolbar button.
2. Modify the displayed bounding box by dragging the corners of the box to the desired locations.
3. Before starting to reconstruct geometry make sure that Selection option is chosen from the Reconstruction volume drop down list.

The photos included in the project file can't be opened and operations from the Workflow menu fail

Probably the locations of photos have changed in respect to the location of the project file. The references to the original photos are stored in the project files in the form of relative paths. These references become invalid when the project file alone is moved to another location, or when the photos are moved without changing the project file placement.

To identify the expected photo location

1. Open the context menu of the photo by right-clicking on its title in the Workspace pane.
2. Select Show Info... command from the context menu.
3. A dialog box with information on the selected photo including the path to the image data file will be displayed.

To fix the problem move the photos to the original locations indicated by the data displayed in the information dialog box.

If the relative location of the project file in respect to the photos location must be changed, the project file should be resaved using the Save As... command from the File menu.

To move the project file in respect to the source photo locations

1. Open the project to be moved using Open... command from the File menu.
2. Select Save As... command from the File menu. Browse to the folder where the project file should be placed and specify the destination file name for the project. Click Save button to save the project.

Once the project file was saved to a new location, the original project file can be removed, if necessary.